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Overview
This manual describes how to install and configure Micro Focus Enterprise Analyzer (EA), a suite of
software products for analyzing and modernizing legacy applications.

Enterprise Analyzer provides insight into the technical reality of complex application portfolios, including:

• Tools for application and program level understanding, utilizing extensive metrics, reports, diagrammatic
views, and querying tools to support a myriad of business initiatives.

• Quality assessment with standard code quality queries to serve as a guidance to a code quality practice
in both development and maintenance phases.

• Portability assessment to help you generate various HTML reports to identify points of interest for
migrations.

• In-depth analysis tools to promote efficiency in the performance of daily tasks such as field changes,
understanding of data propagation through a program, and dead code removal.

Business Rule Manager mines business logic from program code and encapsulates the logic in business
rules.

While all products are installed with Enterprise Analyzer, each product is licensed separately.

EA is deployed in a multi-user environment with access to a common repository of application objects.
Repository set up is the responsibility of a master user, leaving team members free to focus on their tasks.
The database for the repository is assumed to be the customer's own.

EA installations consist of the following components:

• The EA Server which hosts EA workspace files and related support files.
• EA Clients which host the link files used to connect to a workspace on the server.

Installation Tasks
The table below describes the tasks involved in installing Enterprise Analyzer and the order in which the
tasks must be performed:

Task Order Notes

Install Database Client 1 The EA package installs SQL Server Express. This is
enough for a small sized repository (up to 10 GB).

Beyond that, a PostgreSQL database client must be
installed wherever the EA client or EA server is installed.
Install only if the database client is not already installed.

Install EA on Server 2

Install EA on Clients 3

See Installation Guide for more information.

Deployment
The figure below shows the standard EA deployment scenario. The role each machine performs and its key
relationships are described in the following sections.
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Mainframe and Network Server
The mainframe typically hosts the application to be modeled in EA. Application source files are
downloaded from the mainframe (and if necessary, a network server) to the EA server via FTP or SFTP.

Repository Server
The Repository Server hosts the database for one or more multiuser repositories, one repository per EA
workspace. This server provides centralized, network-accessible storage for parsed data and analysis
output.

EA Server
The EA Server hosts workspaces, workspace support files, including the copies of application source files
EA creates at workspace loading and workspace output. This server leverages multiple processes to
enhance parsing performance in online or batch mode.

Parsed data is sent via ODBC to the repository server. Some analysis output is stored on the EA server as
well.

Note: In a multi-user environment, the EA Server cannot reside on the same machine as the EA
Repository. The installation program is the same for the EA Client and EA Server.

EA Client
EA Clients host the link files that let team members connect to workspaces on the EA server. These clients
access repository data stored in the repository server via ODBC.

Note: The installation program is the same for the EA client and EA server.

Single User Installation
You can configure Enterprise Analyzer to build a workspace on one machine for a single user. You can use
Microsoft PostgreSQL - installed by default - to create a workspace on your local machine. EA creates a
database for the workspace "on the fly," with no intervention on your part. If you do use PostgreSQL, bear
in mind that the Windows user who creates the workspace must have been configured with appropriate
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permissions in PostgreSQL. The user who installed PostgreSQL will always have the appropriate
permissions. See the PostgreSQL documentation for configuration instructions.

Database Setup
If you use PostgreSQL, your must set up a schema for each repository you plan to create. Each EA user
who accesses the repository must supply credentials for a database user with appropriate access
privileges to the repository.

If you use Microsoft SQL Server, you must set up a SQL Server database for each workspace repository
you plan to create. EA users typically supply Windows credentials to access the repository.

SQL Server Database Setup
If you use Microsoft SQL Server, you must set up a SQL Server database for each workspace repository
you plan to create. If EA users connect to the repository through an SQL Server login account, ensure the
server authentication property is set to SQL Server and Windows Authentication mode, as described
below.

The following instructions assume you are using the SQL Server Management Studio tool for SQL Server.

Note: The steps might vary depending on the version of SQL Server Management Studio being used.

1. Click Start > Programs > Microsoft SQL Server > SQL Server Management Studio.

2. In the Connect to Server screen, select:

• Database engine in the Server type list.
• The server on which you want to create the repository database in the Server name list.
• Windows Authentication in the Authentication list.

3. Click Connect. The Microsoft SQL Server Management Studio window opens. In the Object Explorer
pane, expand the folder for the server. Click Databases and choose New Database from the right-click
menu. The New Database window opens.

4. Select the General page. In the Database name field, enter the name of the database for the
repository. Modify the logical name and initial sizes of the database and log files if needed, then click
OK. The new database is displayed in the Object Explorer pane.

Note: The database collation should be case insensitive. Additionally, check the SQL Server
Management Studio documentation for details on other database settings.

5. If you connect to the workspace repository through a Windows user account, skip the remaining steps.
If you connect to the workspace repository through an SQL Server login account, click the server name
in the Object Explorer pane and choose Properties from the right-click menu. The Server Properties
window opens.

6. Select the Security page. In the Server authentication area, select SQL Server and Windows
Authentication mode, then click OK.

7. In the Object Explorer pane, click Security > Logins and choose New Login from the right-click
menu. The Login - New window opens.

8. Select the General page. In the Login name field, enter the database login name, then choose SQL
Server authentication. Enter the password for the database login in the Password and Confirm
password fields, then click OK. The new login is displayed in the Object Explorer pane.

9. In the Object Explorer pane, expand the database you created for the workspace repository. Click
Security > Users and choose New User from the right-click menu. The Database User - New window
opens.

10.Select the General page. Define the database user:
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• In the User name field, type the database user name.
• In the Login name field, type the database login name. Use the Browse button to browse for the

login name.

Note: You specify the login name, not the database user name, when you create or connect to
a workspace, so it is usually best to make the user name and login name the same.

• In the Database role membership pane, check db_owner, then click OK. The new user is displayed
in the Object Explorer pane.

Tip: You can use the same login and database user for multiple databases or workspaces.

You can configure Enterprise Analyzer to build a workspace on one machine for a single user. You can use
Microsoft PostgreSQL - installed by default - to create a workspace on your local machine. EA creates a
database for the workspace "on the fly," with no intervention on your part. If you do use PostgreSQL, bear
in mind that the Windows user who creates the workspace must have been configured with appropriate
permissions in PostgreSQL. The user who installed PostgreSQL will always have the appropriate
permissions. See the PostgreSQL documentation for configuration instructions.

Note: SQL Server database transaction logs can become full, resulting in errors. To avoid this, Micro
Focus recommends that you turn off transaction logging or implement automatic log recycling so that
normal EA processing is not interrupted. EA does not use the SQL recovery processes so the
transaction logging is not required, but it is recommended that the database is regularly backed up.

collation

Configuring SQL Server for Multi-user Environments
When installing Microsoft SQL Server or SQL Server Express, ensure that the following points have been
configured appropriately:

1. Ensure that SQL Server Browser service is running and set to start automatically. You can enable the
SQL Server Browser using the SQL Server Configuration Manager or the Windows Services App.

2. Ensure that both the server and client are configure for TCP/IP for 32bit connections. The default port to
use is 1433.

3. If Enterprise Analyzer is running on a remote machine to the Microsoft SQL Server or SQL Server
Express installations, ensure that the server is configured to accept remote connections.

4. Ensure that the users are registered in the database and they are active and can connect to the SQL
Server.

5. Ensure that the users use the dbo alias when connecting to the database that holds the workspace.
6. All users must have the db_datareader and db_datawriter roles. In addition, the master users of the

workspace must also be granted the db_owner database role.
7. All users must be granted execute permissions on the stored procedures that are created by Enterprise

Analyzer.
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Hardware and Software Requirements
The following sections describe the hardware, disk space, operating system, and software requirements for
EA installations.

Repository Server Hardware Requirements
The table below lists the hard drive storage requirements for the Repository Server. For other hardware
recommendations, check with support services:

Type Requirement Notes

Hard Drive Storage Variable Minimum of 20 GB disk space needed for the
software installation of the RDBMS and the
EA template database. Plus approximately
60x the size in bytes of the application source
code modeled in EA, for example, 100 MB
source = 6 GB.

Repository Server Software Requirements
The table below lists the software requirements for the Repository Server:

Type Requirement

SQL Server MS SQL Server 2012, 2014, 2016, 2017, 2019, or 2022 (SQL
Server 2017 or later is required for Windows 11 or Windows
Server 2022)

PostgreSQL PostgreSQL 13 or later.

EA Server Hardware Requirements
The table below lists the hardware requirements for EA Server installations. Hardware requirements can
vary depending on the size of the application you are analyzing:

Type Requirement Notes

Processor 2.6 GHz Dual Core or 2x 3.0+ GHz
Processors

Dual processing capability with multiple cores
in a processor or separate physical
processors.

Physical Memory 3 GB RAM

Virtual Memory 1 GB to 3 GB

Hard Drive Storage Variable For EA workspaces, approximately 40x size
in bytes of the application source code
modeled in EA, for example, 100 MB source
= 4 GB.

For EA software, minimum 200 MB.

For database client, minimum 200 MB.
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EA Server Software Requirements
The table below lists the software requirements for EA Server installations:

Type Requirement

Operating System Microsoft Windows Server 2016, 64-bit

Microsoft Windows Server 2019, 64-bit

Microsoft Windows Server 2022, 64-bit

Microsoft Windows 10, 64-bit

Microsoft Windows 11, 64-bit

Database Client For PostgreSQL the 64-bit ODBC Unicode driver is required.

Pre-Requisite Software Note: The pre-requisite software is automatically
installed by the installer.

• Sentinel RMS License Manager
• .NET 6.0.14
• Visual C++ Redistributable (2015-2022) 14.34.31931.0
• SQL Server 2022 Express (optional install)
• Apache Tomcat 9.0.71 (optional). Needed for EA Web

deployment.

Web browser Required to view HTML report outputs or to access the Web
client.

• Internet Explorer 6.0 or later (optional)
• Mozilla Firefox 3.6 or later
• Chrome 6 or later

Microsoft Office (optional) Required by EA tools with reporting capabilities to save to
Microsoft Office file formats. Excel is required for standard
deviation charts in the Executive Report.

Microsoft Visio (optional) Required to generate output as Microsoft Visio files.

Note: When the Visio version is 2013 or later,
the .VSDX format is used instead of .VSD.

OpenJDK JRE 8.0 or later (optional) Required for Java parsing.

EA Client Hardware Requirements
The table below lists the hardware requirements for EA Client installations. Hardware requirements can
vary depending on the size of the application you are analyzing:

Type Requirement Notes

Processor 3.0 GHz Processor Single processor (single or dual core).

Physical Memory 1GB RAM

Virtual Memory 1GB to 3GB

Hard Drive Storage Variable For EA software, minimum 200MB.

For database client, minimum 200MB.
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EA Client Software Requirements
The table below lists the software requirements for EA Client installations:

Type Requirement

Operating System Microsoft Windows Server 2016, 64-bit

Microsoft Windows Server 2019, 64-bit

Microsoft Windows Server 2022, 64-bit

Microsoft Windows 10, 64-bit

Microsoft Windows 11, 64-bit

Database Client For PostgreSQL the 64-bit ODBC Unicode driver is required.

Pre-Requisite Software Note: The pre-requisite software is automatically
installed by the installer.

• Sentinel RMS License Manager
• .NET 6.0.14
• Visual C++ Redistributable (2015-2022) 14.34.31931.0
• SQL Server 2022 Express (optional install)

Web browser Required to view HTML report outputs or to access the Web
client:

• Internet Explorer 6.0 or later (optional)
• Mozilla Firefox 3.6 or later
• Chrome 6 or later

Microsoft Office (optional) Required by EA tools with reporting capabilities to save to
Microsoft Office file formats. Excel is required for standard
deviation charts in the Executive Report.

Microsoft Visio (optional) Required to generate output as Microsoft Visio files.

Note: When the Visio version is 2013 or later,
the .VSDX format is used instead of .VSD.

OpenJDK JRE 8.0 or later (optional) Required for Java parsing.
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EA Performance Optimization Guidelines
This section describes the optimal performance environments in which to run Enterprise Analyzer,
including selecting the right hardware configuration for specific types of usage, and optimizing the EA
configuration for the selected configuration. The suggestions for performance improvements are focused
on the repository build phase of the workspace.

The most time-consuming and hardware-intensive aspects of running Enterprise Analyzer are the source
verification and database loading during the workspace build phase. The guidelines include suggestions for
improving performance by using multiple Queue Processors and taking advantage of multiple CPU cores,
using the parallel verification option which determines the number of used Queue Processors, and
guidelines for defining the number of Queue Processors needed for a given configuration of available
machines and database server power.

There are two deployment scenarios for Enterprise Analyzer:

• Single User - this is typically a mobile user, such as a consultant on a laptop, who uses the repository
for demonstration or assessment purposes.

• Enterprise Installations - several computers are used, typically one for a database server, one for
workspace and multiple user machines.

Choosing Hardware Configuration

Single User (One Machine)

Minimum Hardware Requirements

Type Requirement Notes

Processor 1.8 GHz, minimum dual core

Physical Memory 2 GB RAM

Hard Drive Storage HDD with at least 20 GB free space For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

With this minimum hardware configuration you can run Enterprise Analyzer and analyze sources.

Suggested Upgrades

The analysis time increases when the number of analyzed sources rises. To reduce the analysis time Micro
Focus recommends that you use one of the following upgrades:

1. A high speed Solid State Drive (SSD) for storing database tables. This can be added as an external
drive; however USB 3.0 or eSATA must be used. This will improve the verification performance by 25%
over the minimum configuration.

2. Use a quad core processor such as Intel Core i7 2670QM or any other quad core QE/QM processor.
This improves the verification performance by 50% over the minimum system configuration.
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Note: You must run additional Queue Processors to benefit from the additional cores. See
Choosing the Optimal Number Of Queue Processors for more information.

Note: Improved verification performance means that if the project verification takes 100 minutes, and
you get 33% performance improvement, the verification time is reduced to 67 minutes.

Recommended Configuration 1

This configuration gives 33% improved verification performance. The changes from the minimum
configuration are marked in bold:

Type Requirement Notes

Processor 2.0 GHz, 2 cores

Physical Memory 4 GB

Hard Disk Drive SSD with at least 20 GB free space For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

Recommended Configuration 2

Recommended configuration 2 gives 50% improved performance of verification. The changes from the
minimum configuration are marked in bold:

Type Requirement Notes

Processor 2.0 GHz, 4 cores

Physical Memory 4 GB

Hard Disk Drive Any type with at least 20 GB free
space

For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

Performance Configuration

The performance configuration is a combination of all upgrades. It gives 66% improved verification
performance. The changes from the minimum configuration are marked in bold:

Type Requirement Notes

Processor 2.0 GHz, 4 cores

Physical Memory 4 GB

Hard Disk Drive SSD with at least 20 GB free space For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

Enterprise Installation (Multiple Users Using Separate
Database Server)
A typical environment where large projects will be verified on a regular basis usually consists of 3 types of
components:

1. Database server (MS SQL Server, PostgreSQL).
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2. EA server with the workspace files. This is the machine where EA is installed and where the EA
workspace folder is located.

Note: There can be more than one workspace.

3. Processing node(s). This is one or more computers running Queue Processors, or hosting the users of
the tool.

Database Server

Minimum hardware requirements

Type Requirement Notes

Processor 2.6 GHz Dual Core or 2x 3.0+ GHz
Processors

Dual processing capability with
multiple cores in a processor or
separate physical processors.

Physical Memory 3 GB RAM

Hard Disk Drive For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

The minimum configuration can be up to four concurrent Queue Processors while providing reasonable
response time. To improve performance, one of the following upgrades should be used:

1. Use faster storage, for example use SSD or storage arrays in RAID0. SSD improves the performance of
verification by 33%. 2x SCSI 15000 rpm gives a similar performance improvement.

2. Use 8 GB of RAM. Increasing the amount of RAM improves the performance of verification by 15%
when using more Queue Processors.

3. Network latency between database server and repository server and users should be less than 1ms.

Recommended hardware configuration

This is the recommended hardware configuration. The changes from the minimum configuration are
marked in bold.

Type Requirement Note

Processor 2.6 GHz Dual Core or 2x 3.0+ GHz
Processors

Dual processing capability with
multiple cores in a processor or
separate physical processors.

Physical Memory 8 GB RAM

Hard Disk Drive SSD or SCSI 15000 rpm in RAID0 For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

Performance Configuration

You get 33% improved performance of verification.

Type Requirement Note

Processor Xeon CPU E5310 or Core i7 3770

Physical Memory 8 GB
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Type Requirement Note

Hard Disk Drive 2x SCSI 15000 rpm RAID0 or 240GB
SSD

Note: Performance configuration can support up to 16 concurrent Queue Processors. Note that user
activity through the online tool should be counted as an active Queue Processor.

EA and Workspace Server
The repository server stores the Enterprise Analyzer workspace folder and files. It is shared on the network
so that other users can access it.

Warning: Micro Focus does not recommend combining the EA server and database server (and even
processing node) for machines with limited resources.

Minimum hardware requirements for Repository Server are:

Type Requirement Note

Hard Disk Drive Minimum of 20 GB disk space
needed for the software installation of
the database software.

For EA workspaces, approximately
60x size in bytes of the application
source code modeled in EA (for
example, 100 MB source = 6 GB).

Storing your workspace on an SSD
drive improves verification
performance by 5%-15%, depending
on your project.

Processing Node/Nodes
This is the machine that runs the Queue Processors and the processes that they start. The minimum
configuration lets you run a single Queue Processor.

Minimum System Requirements

Type Requirement

Processor 3.0 GHz single core or 2 GHz dual core

Physical Memory 2 GB

Virtual Memory 1 GB to 3 GB

Hard Disk Drive 1 GB

The minimum system lets you analyze small volumes of sources and use the basic functionality of the tool.
To determine the optimal amount of Queue Processors for your Processing node. See Choosing the
Optimal Number of Queue Processors for more information. To improve the performance, some of the
following upgrades can be used:

1. Use more CPUs or CPU cores. Enterprise Analyzer scales well so the performance improvement
matches the CPU cores added - verification performance is improved by 90% when CPU cores are
doubled. The limit is eight physical cores that exclude hyper-threading, with 16 queue processors. Each
concurrent Queue Processor instance needs up to an additional 2GB of RAM. Make sure your database
server can support the additional Queue Processors. See Database Server for more information.

2. Use more computers as processing nodes.
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Recommended Configuration (66% improved performance of verification)

Type Requirement

Processor 3 GHz quad core CPU

Physical Memory 4 GB

Hard Disk Drive 4 GB

As these processing nodes communicate extensively with the database server, a low-latency network is
required between processing node(s) and database server.

Note: For best results, the computers must be on the same local network. You can use a repository
server or a database server (or both) as processing nodes, provided that Microsoft Windows is
installed.

Software Configuration

Verification Information
Verification is the process of analyzing the code loaded into Enterprise Analyzer. The verification process
requires a lot of CPU power. Enterprise Analyzer is designed to use a single CPU core for the main
application, but each Queue Processor can run on a separate CPU core. The Queue Processors can even
run on multiple computers to help with the verification database loading. There are two ways of initiating
the verification process. The first is the online tool Enterprise Analyzer and the second is through the Batch
Refresh Process (BRP).

Parallel Verification
By default, Enterprise Analyzer uses serial verification both for the online tool and for BRP. If you have a
multi-core CPU, it is better to use parallel verification.

To enable it in Enterprise Analyzer:

1. Click Options > Workspace Options.

This opens the Options - Workspace dialog box.
2. Click Verification > Parallel Verification tab.
3. Check either:

• Run Parallel Verification in the Online Tool
• Run Parallel Verification in BRP

4. Adjust the Minimum Queue Processors to improve performance when using an optimized number of
CPU cores.

Note: On a quad-core CPU you get up to 4 times improved performance provided that you use the
optimal number of Queue Processors.

Choosing the Optimal Number of Queue Processors
The optimal number of Queue Processors is related to the number of physical CPU cores available.

If you have x physical CPU cores you should use at least x Queue Processors. Using more Queue
Processors than physical CPU cores slightly increases performance but depending on your system setup it
could also slow down the verification because of the large number of concurrent IO operations.
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Note: Micro Focus recommends using the number of physical CPU cores multiplied by two.

Using More Computers
You can start a new Queue Processor on another computer to help the current verification.

Note: EA must be installed on the computer that launches a Queue Processor:

1. Open Micro Focus Enterprise Analyzer Administration and click Administer > Build New Connection.

This opens the Options - Define Server Workspace Connection dialog box.
2. Specify any required database provider and associated connection details.
3. In the Save Link As (*.rwp) field, browse to the location and type the name of a .rwp file to be created

that will enable a connection to the workspace that will assist during the verification and database
loading.

4. Click OK.
5. Click Administer > Launch Queue Processor.

This opens the Launch Queue Processor dialog box.
6. Specify the local .rwp file created in step 3, for the workspace and enter the number of Queue

Processors that you want to start.
7. Click OK.
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Installing and Uninstalling Enterprise
Analyzer

Before running an installation program described in this section, make sure you have administrative
permissions for the machine on which you are performing the installation. If you do not have administrative
permissions, the installation program will not let you continue.

Note: You can run the Windows Installer (.msi) installation program silently. That is particularly
useful when you are installing clients on a network. Check with support services for the appropriate
sequence of commands.

Installing the Database Client
If you use PostgreSQL, a database client must be installed wherever the EA client or EA server is installed.

Installing EA on the Server or Client
The EA Server hosts EA workspace files and related support files. EA Clients host the link files used to
connect to workspaces on the server. Follow the instructions in this section to install EA on the client or
server. The Micro Focus License Manager is packaged with the installation.

Note: Having the EA server and the database on separate machines could improve performance. The
installation program is the same for the EA client and EA server.

1. Double-click EnterpriseAnalyzer.exe. Note that there might be a version number in the name of
the .exe file.

2. Change the installation directory if not installing to the default location.

3. Select which optional installs you want to include:

• PostgreSQL
• Web Client
• Micro Focus Enterprise Analyzer Administration Tool which is required for the server but not required

for the client.

4. Read the End User License Agreement and check I agree to the End User License Agreement.

5. Click Install.

Uninstalling Enterprise Analyzer
Follow the instructions below to uninstall an Enterprise Analyzer product. Make sure you close any open
EA programs before running the uninstall program.

1. Click Start > Control Panel > Programs > Programs and Features > Uninstall a program

2. In the Uninstall or change a program window, right-click the product you want to uninstall, then click
Uninstall. You are prompted to confirm that you want to uninstall the product. Click Uninstall.
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Post-Installation Administrative Tasks
Before you can work in Enterprise Analyzer, you must complete the basic administrative tasks described in
this section. You are prompted to perform the first of these tasks, configuring the EA, when you complete
the installation.

Important: Before performing the upgrade on your workspaces, Micro Focus strongly recommends
that you back up the database and the workspace folder including the .rwp file.

Configuring Enterprise Analyzer
Use the Configuration Manager in the Enterprise Analyzer Administration tool to configure EA options and
displays for the programming languages, dialects, character sets, and products in use at your site.

If you configure your EA for COBOL, for example, you will see only the EA options and displays appropriate
for COBOL modernization. You need to configure your EA for PL/I as well, you can come back to the
Configuration Manager later and select PL/I in addition to COBOL.

Note: The Enterprise Analyzer Administration tool will prompt to be run with elevated privileges. This
is required because some features of the tool require write access to the Program Files directory.

1. Open the Configuration Manager window.

• If you are installing EA, the Configuration Manager window opens after you finish the installation.
• If you have previously installed EA and want to reconfigure it, choose Start > Programs > Micro

Focus > Enterprise Analyzer > Enterprise Analyzer Administration. The Enterprise Analyzer
Administration window opens. In the Administer menu, choose Configure Micro Focus Enterprise
Analyzer. The Configuration Manager window opens.

Note: If EA is open, you are prompted to exit. Click OK, then close EA.

2. Select each programming language, dialect, and character set in use at your site. Select each EA
product you want to use at your site. The core Application Analyzer product is always selected. Select
Additional Tools to enable tools not used in typical EA configurations. When you are satisfied with your
choices, click OK.

Note: If you modify your EA configuration, make sure you upgrade workspaces created under the
previous configuration.

Note: The Enterprise Analyzer Administration tool will prompt to
be run with elevated privileges. This is required because some
features of the tool require write access to the Program Files
directory.

Licensing
Although Enterprise Analyzer and Business Rule Manager are both installed by the Enterprise Analyzer
installer, each product is licensed separately. Follow the instructions in the topics listed below to manage
your licenses.
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Upgrading Customers
A customer upgrading from Modernization Workbench version 3.1 or later may use the existing license key
to enable Enterprise Analyzer for the same number of users.

Concurrent Use
You can license Enterprise Analyzer and Business Rule Manager for concurrent use. In this mode, one
license key for the purchased number of end users will be registered to a license server and each user
instance will contact it for authorization.

Enterprise Analyzer Licensing
A Sentinel RMS license server is installed with Enterprise Analyzer.

Depending on the licensing model in use at your site, you can manage your license:

• Locally, using the installed Sentinel RMS license server.
• Remotely, using a Sentinel RMS license server that has been configured to manage licenses centrally.

Note: The remote license server uses the same software as the local license server that is
installed with Enterprise Analyzer.

You will need to apply a license in the Micro Focus License Administration to use Enterprise Analyzer. To
start the Micro Focus License Administration, choose Start > All Programs > Micro Focus License
Manager > License Administration.

• If you use a local license server, you can apply a license using an authorization code or a licensing file
in the Install tab of the License Administration.

• Authorization code: Enter the 16-character license authorization code for Enterprise Analyzer, then
click Authorize.

• Licensing file: Enter your downloaded license file (.mflic) by browsing or dropping the file, then click
Install Licenses.

• If you use a remote license server, click Options > Advanced Configuration, then click Change in the
License server field. Enter the IP address or server name of the license server, then click Save.

Your License System Administrator can tell you which licensing model your site uses and provide you with
the name of the remote license server if needed. For complete information, including how to configure a
remote license server, refer to the help provided with the License Administration tool.

Business Rule Manager Licensing
Trial licenses are not provided for Business Rule Manager. Before you can work with it, you must enter the
16-character license authorization code:

1. Start Micro Focus License Manager > License Administration.
2. In the Licence Administration tool, click the Install tab.
3. In the Enter authorization code field, type the authorization code and then click Authorize.

Rocket Software End User License Agreement
IMPORTANT: ROCKET SOFTWARE, INC. OR ITS AFFILIATE DESIGNATED IN THE ENTITY TABLE
LOCATED AT www.rocketsoftware.com/company/legal/AMC-assigned-entity ("LICENSOR") PROVIDES
LICENSED SOFTWARE TO LICENSEE (HEREINAFTER "CUSTOMER") UNDER THIS END USER
LICENSE AGREEMENT (THE "AGREEMENT"). THIS AGREEMENT GOVERNS CUSTOMER'S
INSTALLATION AND USE OF THE VERSION OF THE LICENSED SOFTWARE IDENTIFIED IN THE
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APPLICABLE PRODUCT ORDER, OR IF NOT ACQUIRED VIA A PRODUCT ORDER, CUSTOMER'S
DOWNLOAD AND INSTALLATION OR USE OF THE LICENSED SOFTWARE CONSTITUTES
ACCEPTANCE OF THIS AGREEMENT. PLEASE READ THIS AGREEMENT CAREFULLY, AS IT
CONTAINS RESTRICTIONS ON CUSTOMER USE OF THE SOFTWARE. THIS AGREEMENT
SUPERSEDES AND CONTROLS OVER ANY OTHER TERMS PROVIDED TO CUSTOMER
REGARDING CUSTOMER'S USE OF THE LICENSED SOFTWARE, WHETHER WRITTEN OR ORAL,
UNLESS A DIFFERENT WRITTEN AGREEMENT IS EXPRESSLY REFERENCED IN A PRODUCT
ORDER OR EXECUTED BY LICENSOR AND CUSTOMER THAT SUPPLEMENTS OR SUPERSEDES
ALL OR PORTIONS OF THIS AGREEMENT. ENTERING INTO THIS AGREEMENT DOES NOT
CONSTITUTE A SALES TRANSACTION.

1. DEFINITIONS. Capitalized terms in this Agreement are defined as follows:

"Additional License Authorization" or "ALA" means the additional specific software license terms
that govern the use of a given software product, including (but not limited to) the provisions of the Non-
Production Licensing Guide. The ALA(s) for Licensed Software are found at https://
www.rocketsoftware.com/company/trust/agreements by product name, or can be provided by Rocket
Software at Customer's request.

"Customer" or "Licensee" means the legal entity or individual that is identified in the applicable Product
Order or who has rightfully received a license to the Licensed Product.

"Documentation" means the user documentation Rocket Software makes available for Licensed
Software.

"Licensed Product" means Licensed Software and Documentation.

"Licensed Software" means the executable version of the software listed in the Product Order or
otherwise provided to or rightfully acquired by Customer. This Agreement will govern the use of any
update to the Licensed Software that Customer receives pursuant to a separate support and
maintenance agreement as described in the Support and Maintenance section below, unless such
update contains, comes with, or is otherwise specifically governed by a different end user license
agreement.

"Open Source Software" means software or other material embedded in or made available with a
Licensed Product where such software or other material is made available under an "open source
license" as this term is commonly understood by members of the open source community, including, but
not limited to, those licenses meeting all the criteria prescribed in the Open Source Definition provided
by the Open Source Initiative (https://opensource.org/osd).

"Product Order" means the combination of a Rocket Software Quote and a purchase order or purchase
order alternative agreed to by the parties for the sale of a license(s) of one or more specific items of
Licensed Software to Customer.

"Rocket Software" or "Licensor" means the applicable Rocket Software entity listed on the Entity
Table.

"Rocket Software Quote" is a quote issued by Rocket Software or its authorized billing agent which
contains the one or more specific items of Licensed Software, quantity, price and other pertinent license
details.

"Third Party Component" means any third party run time or other elements embedded in Licensed
Software other than Open Source Software.

"Third Party Software" means additional or accompanying third party software (other than Open
Source Software or Third Party Components) that is specified in the Documentation or in a file
accompanying Licensed Software.

"Warranty Period" means the 90-day period starting from the date Licensed Software is delivered to
Customer.

2. PRODUCT ORDERS. The licensing of software products takes place under Product Orders which
(unless stated otherwise in the Product Order) incorporate the terms of this Agreement. Any terms that
conflict or are in addition to the terms of this Agreement or any applicable ALA ("Inconsistent Terms") in
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a purchase order or other document issued by Customer are rejected by Rocket Software and have no
force and effect. If there is any Inconsistent Term(s) in a Product Order, such Inconsistent Term(s) shall
not apply except where such Inconsistent Term(s) is contained in a Rocket Software Quote or a Product
Order that is signed by both parties. Open Text Corporation("OpenText") and its affiliates are temporarily
providing quoting and invoicing service for certain Rocket Software products and services and is acting
as a billing agent for Rocket Software until further notice. Rocket Software will provide relevant billing
and payment information as and when the transition to Rocket Software invoicing and billing systems
occurs. Rocket Software is not otherwise affiliated or associated with Micro Focus or OpenText. "Micro
Focus" and "OpenText" are registered trademarks of OpenText or its affiliates.

3. LICENSING.

a. License. Except as specifically permitted in the applicable ALA, or as described in the Evaluation
Licenses section below, Rocket Software and its affiliates, respectively deliver and license to
Customer the Licensed Products under a non-transferable, non-sublicensable, non-exclusive license
to use Licensed Software and its Documentation as set out in this Agreement and/or the applicable
ALA and solely for Customer's internal business operations and not for further distribution or
commercialization.

b. Evaluation Licenses. Except as specifically permitted in the applicable ALA, when Rocket Software
and its affiliates, respectively deliver and license the Licensed Products solely for evaluation,
Customer receives a non-transferable, non-sublicensable, non-exclusive license to use Licensed
Products for internal evaluation and testing purposes only, and not for any development, production,
distribution or commercial purpose ("Evaluation License"). The term of an Evaluation License will
be 30 days starting from the date Licensed Product is delivered (i.e., made available for download or
physically delivered) to Customer ("Evaluation Term"), unless Rocket Software authorizes a
different period in writing. The Licensed Product is provided "as is" and there are no warranties or
obligations for Rocket Software to provide support. The Evaluation License terminates at the end of
the Evaluation Term, and Customer is required to return, or, if Rocket Software so directs, delete and
destroy, all copies of such Licensed Product and provide Rocket Software with written confirmation
of its compliance with this provision within 30 days of the end of the Evaluation Term. The Evaluation
License for any prerelease or beta versions of Licensed Software ("Pre-Release Software") shall be
for a term of 90 days unless Rocket Software authorizes a different period in writing. Customer
agrees to promptly report to Rocket Software all problems (including errors, failures, nonconforming
results, and unexpected performances) and any comments regarding the Pre-Release Software and
to timely respond to all questionnaires submitted by Rocket Software regarding the results of
Customer's testing of the Pre-Release Software. Rocket Software may choose not to release a final
version of the Pre-Release Software or, even if released, to alter prices, features, specifications,
capabilities, functions, release dates, general availability, or other characteristics of the Pre-Release
Software.

4. USE RESTRICTIONS.

a. Except as specifically permitted in the applicable ALA or Documentation, Customer will not, directly
or indirectly:

a. Use Licensed Software for time-sharing, outsourcing, hosting, service bureau or like use, or
permit access by, or use for the benefit of, any third party;

b. Modify or create derivative works of Licensed Software;
c. Reverse engineer, decrypt, disassemble or otherwise attempt to discover the source code of

Licensed Software, except to the extent permitted by applicable law;
d. Unbundle component parts of Licensed Software for separate use, where Licensed Software with

multiple components is provided to Customer as a single product;
e. Publish or disclose to third parties any evaluation or benchmarking of Licensed Software; or
f. Alter, destroy, or remove any proprietary notices or labels on or embedded in Licensed Software.

b. Customer may make a reasonable number of archival copies of Licensed Software and
Documentation, and will reproduce all copyright and other proprietary rights notices appearing in or
on Licensed Products, including notices of all third party suppliers, on all permitted copies.

5. TERM. This Agreement and the license term for the Licensed Software granted herein is perpetual,
unless a subscription/term license has been purchased by Customer (in which case the license term
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shall be set forth in the Product Order or ALA), and is subject to earlier termination as provided in the
Termination section below. If Customer has purchased a subscription/term license, such license shall
automatically terminate upon expiry of such subscription/term, unless earlier terminated in accordance
with this Agreement.

6. TERMINATION. Except as set forth herein, either party may terminate this Agreement, and/or any
license granted, on written notice if the other party materially breaches the terms of this Agreement, or
any applicable ALA or Product Order and does not cure the breach within 30 days of the date such
party is notified of such breach. Rocket Software may terminate this Agreement, along with any or all
licenses then in effect with Customer, immediately by giving Customer written notice of termination in
the event that (i) Customer becomes insolvent, has a receiver appointed, or files for or has filed against
it, liquidation, bankruptcy or analogous proceedings; or (ii) Customer infringes or misappropriates the
intellectual property rights of Rocket Software. Termination shall be without prejudice to any other rights
or remedies a party may have. In the event of any termination, Customer's license(s) to install, access
or use the Licensed Software will immediately terminate, and Customer shall destroy and erase all
copies of such Licensed Software in its possession or control and provide written certification to Rocket
Software that it has complied with this provision. Early termination of this Agreement or any Product
Order will not entitle Customer to any credit or refund or reimbursement of any previously paid fees.

7. SUPPORT AND MAINTENANCE. Customer is not entitled to any updates to Licensed Software, unless
Customer purchases (or may receive under a subscription/term license) maintenance and support
services pursuant to Rocket Software's then current applicable standard maintenance and support
agreement (which is found at https://www.rocketsoftware.com/company/trust/agreements or can be
provided by Rocket Software at Customer's request).

8. HARDWARE. In the event that Rocket Software provides Licensed Software embedded in an appliance,
or provides hardware to Customer for use in conjunction with Licensed Software, additional hardware
terms and conditions will apply. In all other instances, Customer will obtain and install any necessary
hardware for proper installation and implementation of Licensed Software.

9. PROFESSIONAL SERVICES. If Customer has Rocket Software or a Rocket Software affiliate perform
any services with respect to Licensed Software (e.g., installation, implementation, maintenance,
consulting or training), Rocket Software or its affiliate will provide those services at its then current
standard terms and conditions and rates unless otherwise agreed in writing by the parties. Customer
may agree to enter into a professional services engagement with Rocket Software or its affiliate through
a separate agreement or statement of work.

10.LIMITED WARRANTY. Rocket Software warrants for the Warranty Period that the Licensed Software
substantially conforms in all material respects to the Documentation, and any media on which Rocket
Software provides Licensed Software is free from defects in materials and workmanship under normal
use.

Customer's sole and exclusive remedy for breach of such warranty is (i) repair or replacement of the
applicable Licensed Software or media free of charge so that it substantially conforms to Documentation
or (ii) if Rocket Software reasonably determines such remedy is not economically or technically feasible,
a refund of the license fee and any maintenance fee paid for the Licensed Software for the current year.
The license to use such Licensed Software will immediately terminate when Customer receives the
refund.

The warranties described herein do not apply if the defects in Licensed Software or media result from:
(i) failure to use Licensed Software in accordance with Documentation, this Agreement or the applicable
ALA; (ii) malfunction of Customer's equipment or network; (iii) accident, neglect, or abuse; (iv) service
by any unauthorized person; (v) other software used by Customer not provided by Rocket Software, or
for which Licensed Software is not designed or licensed for such use; or (vi) any other cause occurring
after initial delivery of Licensed Software or media to Customer, unless directly caused by Rocket
Software. For purposes of this Agreement, Licensed Software is deemed delivered when it is first made
available for download by, or physically delivered to, Customer.

Rocket Software has no responsibility for any claims made outside the Warranty Period.

The warranties described herein also apply to Third Party Components, but do not apply to (i) any free-
of-charge Licensed Software or updates provided following the Warranty Period; or (ii) third party
software that is not a Third Party Component.
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11.DISCLAIMER OF WARRANTY. Except for the limited warranties herein, Licensed Products are
provided "as is" without warranty of any kind. To the extent permitted by law, all implied or
statutory terms, conditions, representations, and warranties (including without limitation all
terms, conditions, representations and warranties regarding merchantability, quality or fitness
for a particular purpose, title or non-infringement, or that may arise out of course of dealing,
usage or trade practice) are expressly disclaimed and excluded to the extent allowed by
applicable law. The limited warranties in this Agreement are provided on the basis that
Customer is procuring Licensed Products for the purposes of a business and not for household
or consumer use. Rocket Software does not warrant that operation of Licensed Software will be
uninterrupted or error-free. Customer has sole responsibility to select Licensed Software that
works with other software, applications or systems to achieve intended results.

12.LIMITATION OF LIABILITY.

a. Liability Cap. In no event will any liability of one party to the other party arising out of or in
connection with this Agreement exceed the total fees paid by Customer for the affected
Licensed Software in the relevant Product Order(s) (including related maintenance and
support). Nothing in this Section shall limit either party's liability for: willful misconduct or
fraudulent misrepresentation; unauthorized use of intellectual property; breach of license;
death or bodily injury caused by negligence; non-payment of amounts owed; or any liability
which may not be excluded or limited by applicable law.

b. Mutual Disclaimer of Consequential Damages. In no event will either party be liable for any
indirect, special, incidental, consequential, punitive or similar damages; loss of profits,
business, data or programs (including, but not limited to, the cost of recovery or replacement
of such data or programs); loss, damage or any costs due to interruption, delay or inability to
use Licensed Software, whether arising out of or in connection with this Agreement, even if
informed of the possibility of such damages in advance.

c. Scope. The limitations and disclaimers herein apply to all causes of action, including but not limited
to, breach of contract, breach of warranty, negligence, strict liability, misrepresentation and other
torts.

d. Exclusive Remedy. The remedies in this Agreement are the parties' exclusive remedies and the
limitations of the Liability Cap section and the Mutual Disclaimer of Consequential Damages section
apply even if these remedies fail of their essential purpose. Customer may have other rights,
including consumer rights, under the laws of the state or country where it is located.

e. Free-of-Charge Software. If Rocket Software provides Customer with any Licensed Software free-of-
charge or under an Evaluation License, to the extent permitted by law, Rocket Software and its
affiliates will not be responsible for any loss or damage to Customer, its customers, or any third
parties caused by that Licensed Software which is free-of-charge.

13.OWNERSHIP. Rocket Software, Inc. and its affiliates and their suppliers own or have the right to use or
further distribute all intellectual property rights in Licensed Products, and authorize Rocket Software to
distribute Licensed Products under this Agreement. Customer's only rights in Licensed Products are the
express licenses referenced in this Agreement or the applicable ALA.

14.OPEN SOURCE SOFTWARE AND THIRD PARTY SOFTWARE. Open Source Software and Third
Party Software are governed by the terms of their respective licenses and not the terms of this
Agreement, notwithstanding anything to the contrary in any applicable ALA. Information about the Open
Source Software may be found in a file accompanying the Licensed Software or in the Documentation
or ALA.

15.LICENSE FEES AND PAYMENT TERMS. Customer will pay the license fees set forth in the applicable
Product Order for Licensed Software within 30 days of the date of invoice. Software license fees are
non-refundable, except as provided herein, and will be paid without deduction or tax withholding.
Software License fees are exclusive of any transportation charges, sales, use, value added, and other
applicable taxes and duties, and all such amounts will be paid or reimbursed by Customer. Customer
will be liable for all outstanding past due amounts, which will accrue interest (at the rate of 1.5% per
month compounded or the maximum rate permitted by law if lower) and any collection costs for
recovery of past due amounts.

16.LICENSE VERIFICATION. Rocket Software has the right to verify Customer's compliance with licenses
to the Licensed Software.
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Customer agrees to keep records sufficient to show Customer's compliance, including serial numbers;
license keys; logs; records identifying machines on which Licensed Software is installed, accessed, or
from which Licensed Software can be accessed; the number of different users accessing or authorized
to access Licensed Software (if applicable); and licensing metrics, reports, and copies of Licensed
Software. Rocket Software may require Customer to provide information about its deployment of
Licensed Software, which may be in the form of a questionnaire. Customer will have a reasonable time
to complete the questionnaire (or other form of request) and provide it to Rocket Software with an
authorized Customer signatory certifying the accuracy of the information furnished. Upon 10 days prior
written notice, Rocket Software or its designated representative may inspect Customer's records,
systems and facilities, during Customer's normal business hours, to verify compliance with licenses to
the Licensed Software. Customer agrees to cooperate with such verification. Information obtained will
be used solely for compliance purposes and will otherwise be subject to the confidentiality provisions of
this Agreement. If Customer has engaged in unlicensed installation, use of, or access to Licensed
Software or infringed or misappropriated intellectual property rights in Licensed Software, or has
otherwise breached this Agreement or an ALA (a "Non-Compliance"), without prejudice to Rocket
Software' other rights or remedies, including, without limitation, injunctive relief, within thirty (30) days'
notice of such Non-Compliance, Customer agrees to purchase sufficient licenses and or subscriptions
and associated support and maintenance (12 months forward and any applicable back support and
maintenance) to cure the Non-Compliance, by paying Rocket Software's current (as of the date of such
additional purchase) list license fees and support and maintenance fees to Rocket Software, plus
interest (compounded at 1.5% monthly or the maximum rate permitted by applicable law if lower) for
such additional licenses from the commencement of the Non-Compliance until payment of the
aforementioned fees, with interest payable even if an invoice was not issued at the time the Non-
Compliance occurred. If Customer's Non-Compliance results in an underpayment of license fees of 5%
or greater, Customer shall also reimburse Rocket Software for the reasonable cost of such audit in
addition to other amounts due.

17.PRIVACY. Customer is solely responsible for, and assumes all liability with respect to, its own collection,
processing, storage, and transfer of any user data, including personally identifiable information,
personal health and financial information, and other forms of personal information (collectively,
"Personal Information"). Customer is solely responsible for notifying its users of proper use of such
data. Customer is solely responsible for assessing the Licensed Product or any related product or
service for compliance with any industry requirements applicable to Customer. Each party must comply
with its respective obligations under all applicable laws, regulations, and industry standards regarding
data collection and data privacy that apply to use of Licensed Software. Personal information or
customer data that Customer provides to Rocket Software for the purpose of receiving products or
services will be handled in accordance with the Rocket Software Global Data Protection and Privacy
Notice (https://www.rocketsoftware.com/company/legal/privacy-policy) and the privacy and data security
provisions in the applicable ALA.

18.USE OF CUSTOMER INFORMATION. To the extent permitted by law, Customer expressly consents to
the collection and use of information about Customer's purchase, installation and use of Licensed
Software and the computer systems on which it is installed or accessed as necessary to fulfill the
Product Order and provide the Licensed Product, for security and licensing purposes and to improve
Rocket Software products and services.

19.CUSTOMER FEEDBACK. Customer agrees that, should it provide Rocket Software with any feedback
or suggestions regarding Licensed Products ("Feedback"), Rocket Software and its affiliates will be free
to use all such Feedback, including (but not limited to) all intellectual property rights in and to such
Feedback, in their discretion and for any purpose, without obligation of any kind to Customer.

20.CONFIDENTIAL INFORMATION. Information exchanged under or in connection with this Agreement,
including all information pertaining to Pre-Release Software, will be treated as confidential if identified
as confidential at time of disclosure, or if the circumstances of disclosure reasonably indicate such
information should be treated as confidential. Confidential information may only be used for the purpose
of fulfilling obligations or exercising rights under or in connection with this Agreement, and shared with
employees, affiliates, agents or contractors with a need to know such information to support that
purpose, who are contractually bound to protect its confidentiality. Confidential information will be
protected using a reasonable degree of care to prevent unauthorized use or disclosure for three years
from date of receipt. These obligations do not cover information that (i) was known or becomes known
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to the receiving party without a duty of confidentiality; (ii) is independently developed by the receiving
party; (iii) becomes publicly available without breach of this Agreement; (iv) is disclosed with the
disclosing party's prior written consent; or (v) where disclosure is required by law, a court or government
agency. Should the receiving party be required to reveal confidential information under subpoena, court
order or other operation of law, the receiving party will provide reasonable prior notice to the disclosing
party and request a protective order, if available.

21.INDEMNIFICATION FOR INTELLECTUAL PROPERTY RIGHTS INFRINGEMENT. Rocket Software
will defend and/or settle any claims against Customer that Licensed Products furnished under this
Agreement infringe a third party's patent, copyright, or trade secret rights. existing under the laws of a
country where Customer is using the Licensed Product ("IP Infringement Claim"), provided: (i)
Customer promptly notifies Rocket Software in writing of the IP Infringement Claim; (ii) Rocket Software
has sole control of the defense and all related settlement negotiations; and (iii) Customer reasonably
cooperates with Rocket Software in the defense of the IP Infringement Claim.

Rocket Software will pay all damages, costs, and expenses finally awarded (or agreed to by settlement)
for any such IP Infringement Claim. Rocket Software will pay all reasonable out-of-pocket costs incurred
by Customer for cooperation in the defense of the IP Infringement Claim. If, however, Customer wants
separate legal representation, Customer will be responsible for the costs and fees of its separate
counsel.

Should any Licensed Products provided under this Agreement become or, in Rocket Software's opinion,
likely become, the subject of an IP Infringement Claim, Rocket Software may replace or modify affected
Licensed Product so as to make it non-infringing and materially equivalent, or procure for Customer the
right to continue using it. If neither alternative is reasonably available, once Customer has returned or
destroyed all copies of the affected Licensed Product, Rocket Software will refund to Customer the full
amount paid for affected Licensed Product less straight line depreciation on a five-year basis from date
of delivery.

Rocket Software is not responsible for unauthorized use of Licensed Products, and has no obligations
under this Section (Indemnification for Intellectual Property Rights Infringement), to the extent
infringement results from (i) compliance with Customer's designs or instructions, (ii) a modification not
authorized in writing by an authorized Rocket Software signatory, (iii) use or combination with software,
equipment, or data not provided by Rocket Software, (iv) non-licensed use; or (v) Third Party Software
or Open Source Software.

22.MISCELLANEOUS.
a. Assignment. Rocket Software may assign this Agreement and any Product Orders to an affiliate or a

third party in connection with an asset sale or divestiture. Customer may not assign or transfer this
Agreement (or any Product Orders) or any of its rights or duties hereunder, including (but not limited
to) by operation of law, without Rocket Software's prior written consent, which will not be
unreasonably withheld, and payment of any applicable assignment or transfer fee. Any transaction or
series of related transactions resulting in a change in the ownership of more than 50% of the voting
equity of Customer will be deemed an assignment for purposes of this provision. Any attempted
assignment of this Agreement (or a Product Order) not in accordance with this section (Assignment)
will be null and void.

b. Governing Law and Jurisdiction. This Agreement and, subject to the Open Source Software and
Third Party Software Section, licenses purchased under applicable Product Orders, as well as any
claims or causes of action, whether in contract, tort or statute, based on, arising under or relating to
this Agreement, will be governed and enforced as follows: If Customer's applicable place of business
is located in North America, all matters arising out of or relating to this Agreement are governed by
the laws of the state of Delaware, U.S.A. If Customer is located in the United Kingdom, Australia,
Brazil, France, Germany, Italy, Japan, the Netherlands, New Zealand, Spain or Singapore, all matters
arising out of or relating to this Agreement are governed by the laws of the country in which Licensee
is located. In the rest of the world, the laws of England and Wales govern all matters arising out of or
relating to this Agreement. The applicable law shall apply without regard to conflicts of law
provisions, and without regard to the United Nations Convention on the International Sale of Goods.
Any suit, action, or proceeding arising out of or relating to this Agreement shall be subject to the
exclusive jurisdiction of the courts of the country determining the applicable law, except that the
courts of the State of Delaware shall have exclusive jurisdiction in North America, and Rocket
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Software will be allowed to apply for injunctive relief in any jurisdiction. Each party agrees to be
subject to the above-described jurisdiction and waives any right it may have to object to such venue,
including objections based on personal jurisdiction or inconvenient forum. The prevailing party in any
proceeding has the right to recover costs and reasonable attorneys' fees as awarded by the court or
arbitrator.

c. Export Control. Rocket Software and Customer will comply with their respective responsibilities as
exporters and importers under laws and regulations applicable to the export, import or other transfer
of the software, services and technology provided by Rocket Software under this Agreement,
including the export, import and sanctions laws of the United States and other applicable
jurisdictions. If Customer exports, imports, or otherwise transfers any Licensed Products provided
under or in connection with this Agreement (or any technical data related thereto), Customer is
responsible for obtaining any required authorizations. Customer will not use Licensed Products for
any purpose prohibited by applicable export laws, including nuclear, chemical, missile or biological
weapons-related end uses. With respect to any Pre-Release Software provided to Customer,
Customer represents and warrants that(i)it is a non-governmental entity,(ii) the Pre-Release Software
will only be used for internal testing and evaluation, and will not be rented, leased, sold, sublicensed,
assigned, or otherwise transferred, and that it will not transfer or export any product, process, or
service that is the direct product of the Pre-Release Software, and (iii) it will only use the Pre-
Release Software in the United States or the countries listed in Title 15, U.S. CFR Supplement No. 3
to Part 740 - License Exception ENC Favorable Treatment Countries. Customer agrees to indemnify
and hold Rocket Software harmless from and against any damages, claims, losses, fines,
settlements, attorneys' fees, legal fees and court costs and other expenses related to any such
activities or any claims in connection with any breach of this Section.

d. Survival. Rights and obligations of the parties in the following Sections: Use Restrictions, Term,
Termination, Disclaimer of Warranty, Limitation of Liability, Ownership, Open Source Software and
Third Party Software, License Fees and Payment Terms, License Verification, Privacy, Use of
Customer Information, Customer Feedback, Confidential Information, Indemnification for Intellectual
Property Rights Infringement, and Miscellaneous will survive termination or expiration of this
Agreement. Neither party will be liable for delays or non-performance beyond its reasonable control
except for payment obligations.

e. Notices. All notices permitted or required under this Agreement will be in writing and delivered
personally, by courier, telecopy, first class mail, electronic mail, or similar transmission to the other
party. Notices to Rocket Software shall be addressed to: Legal Department, Rocket Software via
email to legal@rocketsoftware.com. Notices to Customer may be sent via electronic mail to any
email address set forth in the Product Order or to its address listed on the applicable Product Order,
or at such other address as may be supplied in writing. The date of delivery or the date of mailing will
be the date of notice.

f. Resellers. Rocket Software's obligations with respect to products or services supplied by Rocket
Software and procured by Customer from an authorized Rocket Software reseller are limited to the
terms and conditions in this Agreement and the Documentation included with the Rocket Software
supplied products and services. With purchases from a reseller, the applicable pricing and payment
terms are as set out in the separate agreement between Customer and the reseller, and any terms
in this Agreement related to Rocket Software pricing and payments shall not apply. Rocket Software
is not responsible for the acts or omissions of the reseller, or for any other products or services that it
supplies to Customer.

g. Entire Agreement. This Agreement and the applicable Product Order(s) and ALA(s) represent the
entire understanding of the parties with respect to the subject matter of this Agreement and
supersede any previous communications or agreements that may exist regarding the same subject
matter.

h. Order of Precedence. Subject to the Product Orders section, any conflicting terms and conditions will
be resolved according to the following order of precedence: the applicable Product Order, the
applicable ALA, and this Agreement.

i. Amendment. No modification of this Agreement will be binding on the parties unless in writing signed
by authorized representatives of Rocket Software and Customer.

j. Waiver. No waiver of any right under or in connection with this Agreement will be effective unless in
writing, signed by authorized representatives of both parties. No waiver of any past or present right
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arising from any breach or failure to perform will be deemed to be a waiver of any future right arising
under or in connection with this Agreement.

k. Publicity. For the term of this Agreement, Rocket Software may use Customer's name in press
releases, product brochures, and other marketing materials to indicate they are Rocket's customer.
Rocket will use Customer's trademarks, service marks, logos or branding, according to any branding
guidelines which Customer makes available to Rocket Software. Licensee hereby agrees to serve as
a reference for the Product(s) at times to be mutually agreed upon. Such references may, as
mutually agreed upon, include activities such as (i) reference calls with or hosting of a site visit with
mutually acceptable prospects; (ii) a published "News Release" announcing the successful
partnership with Rocket no later than sixty (60) days from the date of this Agreement; (iii) mention of
Licensee or Licensee logo on Rocket Software's website; (iv) the completion of a "Case Study;" or
(v) sharing Licensee's "Success Story" which may include speaking at Rocket Software events. Both
parties will agree to the content and timing of any announcement focused on their relationship prior
to distribution.

l. Severability. If any provision in this Agreement or the applicable ALA(s) or Product Order(s) is held
invalid or unenforceable, that provision will be construed, limited, modified or, if necessary, severed,
to the extent necessary, to eliminate its invalidity or unenforceability, and the other provisions will
remain unaffected.

Configuring an ODBC Data Source Name
An ODBC data source name (DSN) is a set of credentials for connecting with a database instance. If you
use PostgreSQL, you must configure a DSN for the database that holds your workspace repositories.

Creating a Shared Folder for Workspaces
The folder in which you plan to create a workspace must be shared with team members. It is typically
convenient to share the folder before you create the workspace, but you can do it afterward if necessary,
then refresh the workspace path as described in Getting Started in the EA documentation set.

You must be an administrator to create a shared folder. Perform the follow steps to create a shared folder
for a workspace:

1. On the EA server, create a folder for an EA workspace.

2. Select the folder and choose Sharing and Security from the right-click menu. This opens the
Properties dialog for the folder. In the Sharing tab for the Properties dialog, select Share this folder on
the network (or, on a machine in a Windows domain, Share this folder). Enter the share name in the
Share name field and click Apply.

Note: Do not embed spaces in the share name. Doing so might cause other users to be unable to
access the folder.

3. Click Permissions. The Permissions for Folder dialog opens. Specify the appropriate permissions for
users sharing the folder and click OK.

Upgrading Workspaces
When you modify your EA configuration, you must upgrade every workspace created with the previous
configuration. Only the master user can upgrade a workspace:

Important: Micro Focus strongly recommends that you backup the database and the workspace
folder along with the .rwp file before performing the upgrade on an important workspace.

1. Choose Start > All Programs > Micro Focus > Enterprise Analyzer > Enterprise Analyzer
Administration. This opens the EA Administration window.
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2. In the Administration window, click Administer > Upgrade Workspace. This opens the Upgrade
workspace dialog box.

3. Choose the workspace you want to upgrade, then click OK. This opens a Workspace Upgrade dialog
box.

4. To begin the upgrade process, click Start. In the Workspace Upgrade dialog box you will see the
upgrade process progress. The components that are being upgraded are highlighted and the checkbox
next to each component is checked when the upgrade is complete. You can Pause the upgrade and
Resume it later.

Note: Upgrades that have stopped due to an error can be reset from the File menu.

5. Optionally, click Administer > Upgrade Workspace. This opens the Workspace Upgrade dialog box.
Click File > Export DDL Script to export the DDL script to perform the upgrade and give it to a DBA.
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Troubleshooting the Installation
Follow the instructions in this section to troubleshoot an EA installation.

Troubleshooting Workspace Access
The folder in which you plan to create workspaces must be shared with team members. If users are unable
to access workspaces, it might be because:

• You have not shared the folder for workspaces. Share the folder, then refresh the workspace path. See
Getting Started chapter for more information.

• You shared the folder for workspaces after creating a workspace, then refresh the workspace path. See
Getting Started chapter for more information.

• You embedded spaces in the value of the Share name field for the folder. Remove the spaces, then
refresh the workspace path. See Getting Started chapter for more information.
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